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Add a New Customer:   
 
• Start Toolkit 2004.   
• In the Check In/Out or Folders Tab click the Create New Customer Folder Button ( ).   
• If necessary, eAuthenticate. Note: Toolkit will force you to eAuthenticate when necessary. 
• In the SCIMS Browser Window, set Location State to Ohio and Service Center to the correct 

location. 
• Enter the correct search criteria (e.g. Type, Name, Tax ID and/or Other) and click the Search Button. 
• Locate the customer under the Common Name column and left click on the Customer Name. 
• In the Enter Customer Information for <customer name> Window, enter the Company/Business 

(enter customer’s “last name” space “first name” unless there is a legitimate business name e.g. Bob 
Evans Farms). Note: Company/Business will become the first part of the Customer Folder name. 

• In the Identifier textbox, enter the operator id. The Identifier must meet three criteria 1) It must be 
unique, 2) It must be less than 12 characters, and 3) It cannot contain the following characters ( \ / : * 
? < > | “ . , ). Note: Toolkit checks for duplicate Identifiers.   

• Click the OK Button to create the New Customer Folder. 
 
Check Out a Customer:   
 
• Start Toolkit 2004.   
• In the Check In/Out Tab click the Go Button.   
• If necessary, eAuthenticate. Note: Toolkit will force you to eAuthenticate when necessary. 
• In the National Conservation Planning Database (NCPDB) Window, click on the gray box to the 

left of the desired customer(s).  Note: To select more than one customer, hold down the Control 
Button and left click on the gray boxes to the left of the additional customers. 

• Click the Check Out Button. Note: When complete, the customer folder is displayed on the right. 
• Note: If a Customer Folder is not listed in the NCPDB or a previously worked on plan is not available 

for a customer, exit Toolkit 2004 and use the Toolkit Check In Wizard to check that customer and/or 
plan into the NCPDB. 

 
Check In a Customer:   
 
• Start Toolkit 2004.   
• Click on the Check In/Out Tab.   
• In the My Checked Out Customers Window, click on the gray box to the left of the desired 

customer(s). Note: To select more than one customer, hold down the Control Button and left click on 
the gray boxes to the left of the additional customers. 

• Click the Check In Button. 
• If necessary, eAuthenticate. Note: Toolkit will force you to eAuthenticate when necessary. 
 
Open a Customer Folder:   
 
• Start Toolkit 2004. 
• Click on the Folders Tabs.  Note: The customer must be Checked Out before you can open their 

folder. 
• Locate the Customer Folder in the Folders Checked Out by <NAME> Window. 
• Double left click on the Customer Folder. 
 
Close a Customer Folder:   
 

• From anywhere in the Customer Folder, click on the Close Folder Button ( ) or ( ).  Note: 
Prior to closing the Customer Folder, save and close any ArcGIS map documents. 
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Start a New ArcGIS Map Document for a Customer:   
 
• Open the customer folder by following the instructions on page 4. 
• Click on the Customer Files Tab and single click on the ArcGIS Projects Folder (first folder in the 

list) to open the folder.  Then double-click the ToolkitGIS_Template.mxd. 
• When ArcGIS starts, it will open up in the Data View.  This view should already contain GIS data 

layers for your county. 
• Select Save As from the File Menu and rename your map document. The ArcGIS_Projects folder 

(under the current customer) is the default folder for all ArcGIS map documents.  
• Enter a file name in the Save Mxd Window.  Note: It is strongly recommended to use the tract (or 

farm) number and program name for the filename (e.g. T1428_EQIP.mxd).  It is also important not to 
use any spaces in ArcGIS map document names.  If you need a space in the filename use an 
underscore “_”. 

• It is important NOT to save the working map document as ToolkitGIS_Template.mxd. This file 
should be maintained in its original state so that it can be reused if the customer needs another map.  

 
Start an Old ArcGIS Map Document for a Customer:   
 
• Open the customer folder by following the instructions on page 4. 
• Click on the Customer Files Tab and single click on the ArcGIS Projects Folder (first folder in the 

list) to open the folder.   
• Open the file by double clicking on the correct map document filename. 
• If the map document was last saved while in Layout View (where maps are created) then select Data 

View from the View Menu. 
• Click on Select a Plan ( ). In the Select a Plan Window, select the correct plan from the pull-down 

menu and click the OK Button.  This will reload previously created planned land units and/or 
practices. 

 
Rename an ArcGIS Map Document for a Customer:   
 
• Open the customer folder by following the instructions on page 4. 
• Click on the Customer Files Tab and click on the ArcGIS Projects Folder (first folder in the list) to 

open the folder.   
• Locate the map document file and right click on the file. Select Rename.  
• Enter the new file name (making sure the filename ends with “.mxd”) and press the Enter Key. 
 
Delete an ArcGIS Map Document for a Customer:   
 
• Open the customer folder by following the instructions on page 4. 
• Click on the Customer Files Tab and single click on the ArcGIS Projects Folder (first folder in the 

list) to open the folder.   
• Locate the map document file and single left click on the file to select it. 

• Click on the Delete File(s) or Folder Button ( ) answer Yes to delete the selected file.  
• Note: Deleting an ArcGIS map document does not delete the conservation plan or any of the 

associated GIS data. To delete a conservation plan and its GIS data see Delete a Conservation 
Plan from a Customer Folder in the Additional Items Section. 

• Note: The Delete File(s) or Folders Button ( ) can also be used to delete other types of non-
essential files and folders from a Customer File. 
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Create a New Plan and PLU Layer (a.k.a. Tract and Field Layer) Using the CLU 
Boundary Layer:  

These instructions are for creating a new PLU layer (a.k.a. tract and field layer) when no land unit records 
(tract and field data) exist, no shapefiles are available for importing, but a FSA CLU (Common Land Unit) 
layer is available as a source layer for creating the PLU layer. 
• Note: When creating PLU from the CLU layer, the CLU land units can be selected manually or via a 

tract or farm number query.   

• If you wish to select the CLU land units manually, use the Select Features Tool ( ) to select land 
units from the CLU layer before proceeding.   

• Click on Create New Layer ( ). 
• Select Planned Land Units in the New Toolkit Layer Window.    

• In the Create Plan Section, choose the Create a new plan database with a new land unit layer 
option. 

• Click in the Layer Name textbox and overwrite the current name. Note: It is strongly recommended to 
use the tract (or farm) number and program name for the filename (e.g. T1428_EQIP) 

• Click the OK Button.  Click Yes to Use Features from a Source Layer. 

• In the Create a New Layer Window, select CLU Boundary from the pull-down menu. 

• To use pre-selected features from the CLU layer, choose the Use Selected Features option. 

• To search by farm/tract number, choose Select by, and choose either tract number or farm number 
from the pull-down menu.   

• To manually select the tract(s)/farm(s) from the list, use the scroll bar to look for the tract/farm 
number(s) and left click on the correct number(s). Note: To unselect, left click on the number. 

• To search for a tract(s)/farm(s), click in the Search for Item textbox, enter the tract/farm number and 
click the Search Button. Note: To search for more than one, repeat this search step.  

• Click the OK Button and click the OK Button to Create plan from selections. 
• ArcGIS will pause and return, the new PLU layer is added to the Table of Contents and the Data 

View will automatically zoom to the extent of the new PLU Layer. The Land Unit Editor Toolbar will 
be present and the new layer will be in Edit Mode. 

• Note: To make changes to the new layer using the Land Unit Editor Toolbar see Editing Planned 
Land Units Section.   

• Select Stop Editing from the Editor Menu on the Land Unit Editor Toolbar. If prompted to save 
edits, choose Yes.   

• Note: If the Land Unit Editor Toolbar is accidentally closed it can be retrieved by clicking the 
Digitizing Button ( ). 

• Click on the Attribute Tool ( ). 

• In the Attribute Tool Window select the PLU layer name from the Select Layer pull-down menu. 

• In the Data View, left click on the first land unit to attribute. Complete the information in the Attribute 
Tool Window for the selected land unit and click the Apply Button. 

• Repeat the above step until all land unit information has been completed. 

• When complete, click the OK Button to close the Attribute Tool Window. 
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Create a New Plan and PLU Layer Without the CLU Boundary Layer:  

These instructions are for creating a new PLU layer when no tabular data exists, no shapefiles are 
available for importing and there is no FSA CLU layer available to use as a source layer. 

• Click on Create New Layer ( ). 
• Select Planned Land Units in the New Toolkit Layer Window.   

• In the Create Plan Section, choose Create a new plan database with a new land unit layer 
option. 

• Click in the Layer Name textbox and overwrite the current name. Note: It is strongly recommended to 
use the tract (or farm) number and program name for the filename (e.g. T1428_EQIP) 

• Click the OK Button.  Click No to Use Features from a Source Layer. 
• ArcGIS will pause and return, the new PLU Layer will be added to the Table of Contents. The Land 

Unit Editor Toolbar will be present and the new layer will be in Edit Mode. 
• Select the Zoom In Tool ( ) and zoom in to the location of new PLU on your map. In the Table of 

Contents turn on any necessary county data layers (e.g. orthophotography). 
• Select the Add Field Tool (  ) from the Land Unit Editor Toolbar. 
• Note: Toolkit 2004 supports two approaches to digitizing PLUs; digitizing the entire tract boundary 

and splitting it to create the fields or digitizing field by field (Tract/Split or Field by Field 
Approaches) 

• Tract/Split Approach (used in CST 4.1): To draw a tract, move the cursor to the starting point and 
left click (one time) to start drawing.  Move the cursor to the next point and left click.  Repeat this 
process until the second to last point (next point being the starting point) and, double left click to close 
the polygon boundary. 

• Note: It is not necessary to return to the starting point to close the polygon boundary. Toolkit 
automatically closes the polygon.  

• Once your tract boundary is completed, make sure it is selected (highlighted blue).  
• Note: For the Split Field Tool to work, a polygon must be selected.  If it is not selected, use the 

Select Field Tool ( ) on the Land Unit Editor Toolbar to select the polygon you want to split.   
• Select the Split Field Tool (  ) from the Land Unit Editor Toolbar. .   
• To create a field, move the cursor to the start location (outside of the tract boundary) then left click 

(one time) to start drawing.  Left click (one time) at each turning point.  Continue until crossing the 
tract boundary a second time, then double left-click.  The field boundary will be snapped to the tract 
boundary and the excess lines (outside the tract boundaries) will be clipped off.  

• Known Bug:  Known bugs exist in the Split Tool. To help avoid this bug be sure to select Save 
Edits from the Editor Menu after each split has been performed.  

• Note:  For the split polygon tool to work, you need to make sure you cross at least 2 boundaries (not 
necessarily tract boundaries) and end your line with a double left-click.   

• Once the field boundaries are complete, select Stop Editing from the Editor Menu on the Land Unit 
Editor Toolbar. When prompted to save edits, choose Yes. 

• Note: If the Land Unit Editor Toolbar is accidentally closed it can be retrieved by clicking the 
Digitizing Button ( ). 

• Click on the Attribute Tool ( ). 

• In the Attribute Tool Window select the PLU layer (e.g. T1428_EQIP) name from the Select Layer 
pull-down menu. 

• In the Data View, left click on the first land unit to attribute. Complete the information in the Attribute 
Tool Window for the selected land unit and click the Apply Button. 

• Repeat the above step until all land unit information has been completed. 

• When complete, click the OK Button to close the Attribute Tool Window. 
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Create a New Plan and PLU Layer Without the CLU Boundary Layer (cont.): 
 

• Field by Field Approach: (Use first 8 steps on previous page) To draw a field using the Add Field 
Tool (  ), move your cursor to the starting point of the field and left click (one time) to start drawing.  
Move the cursor to the next point and left click.  Left click (one time) at each turning point until the 
second to last point (next point being the starting point) has been reached. Double left-click to close 
the polygon boundary.   

• Note: It is not necessary to return to the beginning point of the field to close the polygon boundary. 
Toolkit will automatically close the polygon.  

• Once the field boundary is completed, repeat the above step (on this page) for the next field(s) (2nd, 
3rd, etc.). If digitizing adjacent fields, overlap the boundaries and Toolkit will remove the overlap.  

• Once the field boundaries are complete, select Stop Editing from the Editor Menu on the Land Unit 
Editor Toolbar. When prompted to save edits, choose Yes.   

• Click on the Attribute Tool ( ). 

• In the Attribute Tool Window select the PLU layer name from the Select Layer pull-down menu. 

• In the Data View, left click on the first land unit to attribute. Complete the information in the Attribute 
Tool Window for the selected land unit and click the Apply Button. 

• Repeat the above step until all land unit information has been completed. 

• When complete, click the OK Button to close the Attribute Tool Window. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 9

Link an Existing Plan to a New PLU Layer Using the CLU Boundary Layer:  

These instructions are for creating a new PLU layer when the conservation planning data already exists, 
there are no shapefiles available for importing but there is a FSA CLU layer to use as a source. 

• Click on Select a Plan ( ) from the Toolkit Toolbar. In the Select a Plan Window, select the correct 
plan from the pull-down menu and click the OK Button.  This will load a previously created plan 
database for which you want to create spatial features. 

• When creating PLUs from the CLU layer, you may select the CLU land units manually, or you may 
query for them using the tract or farm number.   

• If you wish to select the CLU land units manually, use the Select Features Tool ( ) to select land 
units from the CLU layer before proceeding.   

• Click on Create New Layer ( ). 
• Select Planned Land Units in the New Toolkit Layer Window.     

• In the Create Plan Section, choose the Link to existing plan database option. 

• In the Existing Plan pull-down menu, select the desired plan database and click the OK Button. 
Click Yes to Use Features from a Source Layer. 

• To use pre-selected features from the CLU layer, choose the Use Selected Features option. 

• To search by farm/tract number, choose Select by, and choose either tract number or farm number 
from the choice list.   

• To manually select the tract(s)/farm(s) from the list, use the scroll bar to look for the tract/farm 
number(s) and left click on the correct number(s). Note: To unselect, left click on the number. 

• To search for a tract(s)/farm(s), click in the Search for Item textbox, enter the tract/farm number and 
click the Search Button. Note: To search for more than one, repeat this search step.  

• Click the OK Button. 
• ArcGIS will pause and return, the new PLU layer is added to the Table of Contents and the Data 

View will automatically zoom to the extent of the new PLU Layer. The Land Unit Editor Toolbar will 
be present and the new layer will be in Edit Mode. 

• Note: To make changes to the new layer using the Land Unit Editor Toolbar see Editing Planned 
Land Units Section.   

• Select Stop Editing from the Editor Menu on the Land Unit Editor Toolbar. When prompted to 
save edits, choose Yes.   

• Note: If the Land Unit Editor Toolbar is accidentally closed it can be retrieved by clicking the 
Digitizing Button ( ). 

• Click on the Attribute Tool ( ). In the Attribute Tool Window select the PLU layer name from the 
Select Layer pull-down menu. 

• In the Data View, left click on the first land unit to attribute. 

• Click on the Link to Tabular Button, select the corresponding land unit record on the right side of the 
Attribute Tool Window, click the Link Button and then click the Apply Button.  

• Continue selecting land units in the view and linking them to their corresponding land unit records. 
When all land unit records have been linked, click the Close Button in the Attribute Tool Window. 

• Use the Attribute Tool to enter the attribute data for the additional land units without existing records. 
• When complete, click the OK Button to close the Attribute Tool Window. 
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Link an Existing Plan to a New PLU Layer Without the CLU Boundary Layer:  

These instructions are for creating a new PLU layer when the conservation planning data already exists, 
but no shapefiles are available for importing and no FSA CLU layer features for the farm are available. 

• Click on Select a Plan ( ) on the Toolkit Toolbar. In the Select a Plan Window, select the correct 
plan from the pull-down menu and click the OK Button.  This will load a previously created plan 
database for which you want to create spatial features. 

• Click on Create New Layer ( ). 
• Select Planned Land Units in the New Toolkit Layer Window.   

• In the Create Plan Section, choose the Link to existing plan database option. 

• In the Existing Plan pull-down menu, select the plan database and click the OK Button. Click No to 
Use Features from a Source Layer. 

• ArcGIS will pause and return, the new PLU Layer will be added to the Table of Contents. The Land 
Unit Editor Toolbar will be present and the new layer will be in Edit Mode. 

• Select the Zoom In Tool ( ) and zoom in to the location of the new PLU on your map. In the Table 
of Contents turn on any necessary county data layers (e.g. orthophotography). 

• Select the Add Field Tool (  ) from the Land Unit Editor Toolbar. 
• Note: Toolkit 2004 supports two approaches to digitizing PLUs; digitizing the entire tract boundary 

and splitting it to create the fields or digitizing field by field (Tract/Split or Field by Field Approaches) 

• Tract/Split Approach: To draw a tract, move the cursor to the starting point and left click (one time) 
to start drawing.  Move the cursor to the next point and left click.  Repeat this process until the second 
to last point (next point being the starting point) and, double left click to close the polygon boundary. 

• Note: It is not necessary to return to the starting point to close the polygon boundary. Toolkit 
automatically closes the polygon.  

• Note: For the Split Field Tool to work, a polygon must be selected.  If it is not selected, use the 
Select Field Tool ( ) on the Land Unit Editor Toolbar to select the polygon you want to split.   

• Select the Split Field Tool (  ) from the Land Unit Editor Toolbar.   
• To create a field, move the cursor to the start location (outside of the tract boundary) then left click 

(one time) to start drawing.  Left click (one time) at every turning point.  Continue until you cross 
another boundary and double left-click.  The new boundary will be snapped to the tract boundary and 
the excess lines (outside the tract boundaries) will be clipped off.  

• Known Bug:  Known bugs exist in the Split Tool. To help avoid this bug be sure to select Save 
Edits from the Editor Menu after each split has been performed.  

• Once the field boundaries are complete, select Stop Editing from the Editor Menu on the Land Unit 
Editor Toolbar. When prompted to save edits, choose Yes.   

• Note: If the Land Unit Editor Toolbar is accidentally closed it can be retrieved by clicking the 
Digitizing Button ( ). 

• Click on the Attribute Tool ( ). In the Attribute Tool Window select the PLU layer name from the 
Select Layer pull-down menu. 

• In the Data View, left click on the first land unit to attribute. 

• Click on the Link to Tabular Button, select the corresponding land unit record on the right side of the 
Attribute Tool Window, click the Link Button and then click the Apply Button.  

• Continue selecting land units in the view and linking them to their corresponding land unit records. 
When all land unit records have been linked, click the Close Button in the Attribute Tool Window. 

• Use the Attribute Tool to enter the attribute data for the additional land units without existing records. 

• When complete, click the OK Button to close the Attribute Tool Window. 
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Link an Existing Plan to a New PLU Layer Without the CLU Boundary Layer 
(cont.):  
 
• Field by Field Approach: (Use first 8 steps on previous page) To draw a field using the Add Field 

Tool (  ), move your cursor to the starting point of the field and left click (one time) to start drawing.  
Move the cursor to the next point and left click.  Left click (one time) at each turning point until the 
second to last point (next point being the starting point) has been reached. Double left-click to close 
the polygon boundary.   

• Note: It is not necessary to return to the beginning point of the field to close the polygon boundary. 
Toolkit will automatically close the polygon.  

• Once the field boundary is completed, repeat the above step (on this page) for the next field(s)(2nd, 
3rd, etc.). If digitizing adjacent fields, overlap the boundaries and Toolkit will remove the overlap.  

• Once the field boundaries are complete, select Stop Editing from the Editor Menu on the Land Unit 
Editor Toolbar. When prompted to save edits, choose Yes.   

• Click on the Attribute Tool ( ). 

• In the Attribute Tool Window select the PLU layer name from the Select Layer pull-down menu. 
• In the Data View, left click on the first land unit to attribute. 

• Click on the Link to Tabular Button, select the corresponding land unit record on the right side of the 
Attribute Tool Window, click the Link Button and then click the Apply Button.  

• Continue selecting land units in the view and linking them to their corresponding land unit records. 
When all land unit records have been linked, click the Close Button in the Attribute Tool Window. 

• Use the Attribute Tool to enter the attribute data for the additional land units without existing records. 

• When complete, click the OK Button to close the Attribute Tool Window. 
 

Link an Existing Plan to an Existing (CST 4.1) PLU Shapefile Layer:  

These instructions are for creating a new PLU layer, when the following conditions apply: 1) There is an 
existing plan database originally created in CST 4.1 (i.e., unmapped land unit records are available in the 
Land Units tab), 2) There is a shapefile that corresponds to those land unit records, and 3) The land unit 
records have not already been linked to that shapefile in Toolkit 2004. 

• Click on Select a Plan ( ). 

• Select the plan database for which you wish to create Planned Land Units (PLUs).  

• Click on Import Legacy Shapefile ( ). 

• Click the Browse Button to locate the shapefile. Note: Browse to the folder C:\Customer Files 
Toolkit\<Customer Folder Name>\Plan_Maps\Plan to find most existing shapefiles. 

• Check the All Planning Land Units checkbox and click the OK Button. 

• The Legacy Shapefile Import Report Window displays the linking status of the plan records and 
shapefiles features. Checked items are linked and uncheck items are not linked. If an item is not 
checked in the left side of the window, that shape will be imported, but you must use the Attribute 
Tool ( ) and the Link to Tabular Button to attach to an unlinked land unit record. 

• Click the OK Button to close the Legacy Shapefile Import Report Window. 
• Note: To make changes to the new layer using the Land Unit Editor Toolbar see Editing Planned 

Land Units Section.   
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Create an Inclusion or Exclusion Area in a PLU Layer:   
 
Occasionally, you will have an area(s) in your PLU layers that do not touch any other field boundary. The 
area(s) may be a field within a field (inclusion) or a hole within a field (exclusion). In both cases the Split 
Field Tool will not work. 

• Known Bug:  Known bugs exist in the Split Tool. Errors are generated when trying to split a 
land unit that is next to a land unit with an inclusion (field within a field). To help avoid this 
problem, perform all splits before creating an inclusion or exclusion in the land units layer. 
For detailed information on the know bugs in the Split Tool see Tech Note 3a at  
www.itc.nrcs.usda.gov/toolkit 

• Make sure the PLU layer is in Edit Mode and the Land Unit Editor Toolbar is open.  
• If the PLU layer is not in Edit Mode, click the Toolkit Digitizer ( ), select the PLU layer name from 

the pull-down menu in the Select Layer to Edit Window and click OK. 
• Select the Add Field Tool (  ) from the Land Unit Editor Toolbar. 
• Move the cursor to the start location (of the inclusion/exclusion) and left click (one time) to start 

drawing.  Left click (one time) at each turning point until the second to last point (next point being the 
starting point) has been reached. Double left-click to close the inclusion/exclusion polygon boundary. 

• Note: It is not necessary to return to the beginning point of the field to close the polygon boundary. 
Toolkit will automatically close the polygon.  

• At this point the inclusion/exclusion should be selected (highlighted blue). 
• If the polygon is an inclusion, select Stop Editing from the Editor Menu on the Land Unit Editor 

Toolbar. When prompted to save edits, choose Yes.   
• Note: The inclusion (and possibly other land unit features) will need to be attributed using the 

Attribute Tool. 
• If the polygon is an exclusion (i.e. a pond), press the Delete Key on the keyboard to delete the 

selected polygon.   
• Select Stop Editing from the Editor Menu on the Land Unit Editor Toolbar. When prompted to 

save edits, choose Yes.   
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Editing a PLU Layer:   
 
These instructions describe how to perform additional edits on a PLU layer. 

• Note: To start editing a PLU layer that is not already n Edit Mode click the Toolkit Digitizer ( ) and 
select the PLU layer name from the Select a Layer to Edit Window. 

• Note: If the Land Unit Editor Toolbar is accidentally closed it can be retrieved by clicking the 
Digitizing Button ( ). 

Split Field Tool 
• Known Bug:  Known bugs exist in the Build 66 Split Tool. To help avoid this bug be sure to 

select Save Edits from the Editor Menu after each split has been performed. The bug also 
arises when trying to split a land unit that is next to a land unit with an inclusion (field within a 
field). To help avoid this bug, perform all splits before creating an inclusion or exclusion in the 
land units layer. For detailed information on the known bugs in the Split Tool see Tech Note 3a 
at  www.itc.nrcs.usda.gov/toolkit 

• Note: For the Split Field Tool to work, a polygon must be selected.  
• Use the Select Field Tool ( ) from the Land Unit Editor Toolbar to select the polygon to be split.   
• Select the Split Field Tool (  ).   
• Move the cursor to the start location (outside of the PLU boundary) then left click (one time) to start 

drawing.  Left click (one time) at each turning point.  Continue until crossing a second boundary, then 
double left-click.  The new PLU boundary will be snapped to the existing PLU boundary and the 
excess lines will be clipped off.  

• Note:  For the Split Field Tool to work, you need to cross at least 2 PLU boundaries. 
• Once the splits are complete, select Stop Editing from the Editor Menu and save edits. 

Merge Field Tool 
• Note: For the Merge Field Tool to work, at least 2 polygons must be selected.  
• Use the Select Field Tool ( ) from the Land Unit Editor Toolbar to select the polygons you want 

to merge (hold the shift key down to select more than one polygon).   

• Click the Merge Field Tool ( ).   
• Click on the desired Tract and Field Attributes (to be used for the newly merged field) in the Select 

Merge Target Window and click OK. 
• Once the merge is complete, select Stop Editing from the Editor Menu and save edits. 
Reshape Field Tool 
• Note: For the Reshape Field Tool to work, a polygon edge must be selected.  

• Use the Topology Edit Tool ( )from the Land Unit Editor Toolbar to select the polygons edge 
you want to reshape (the selected edge will highlight purple). 

• Click the Reshape Field Tool ( ).   
• Click inside or outside the edge you want to shape, next cross the edge boundary, left click at each 

turning point. Continue until you cross the edge boundary a second time and double left click to 
complete the reshape. The previously selected edge should change to the newly digitized edge. 

• Note:  For the Reshape Field Tool to work, you need to cross at least 2 PLU boundary edges. 
• Once the reshaping is complete, select Stop Editing from the Editor Menu and save edits. 
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Editing a PLU Layer (cont.):   
 
Edit Vertices Tool 
• Note: For the Edit Vertices Tool to work, a polygon edge must be selected.  

• Use the Topology Edit Tool ( ) from the Land Unit Editor Toolbar to select the polygons edge 
you want to reshape (the selected edge will highlight purple). 

• Click the Edit Vertices Tool ( ) from the Land Unit Editor Toolbar. The vertices for the selected 
edge will appear (green squares).  

• To move a vertex, place the cursor over the vertex, left click and hold then drag and drop in the new 
location. Repeat this process until complete then stop editing. 

• To delete a vertex, place the cursor over the vertex, right click and select Delete. Repeat this 
process until complete then stop editing. 

• To insert a vertex, place the cursor over new vertex location, right click and select Insert Vertex. 
Repeat this process until complete then stop editing. 

• Once the vertex edits are complete, select Stop Editing from the Editor Menu and save edits. 
Copy and Paste Field Tools 
• Note: This tool is used to copy features from another layer (GPS data shapefile, Resource Inventory, 

Build Your Own Polygon, etc.) into the Planned Land Units layer. 
• Turn off (uncheck) all other layers except the “copy from” layer, the PLU layer and photography layer.  
• In the Table of Contents (where the layer names are listed) left click one time on the “copy from” 

layer name (it will highlight dark blue). 
• Use the Select Tool ( ) on the ArcGIS Toolbar (not the Land Unit Editor Toolbar) and click on 

the polygons you want to copy (hold the shift key down to select more than one polygon). 

• Click the Copy Field Tool ( ) on the Land Unit Editor Toolbar. 
• In the Table of Contents (where the layer names are listed) left click one time on the PLU layer 

name (it will highlight dark blue). 

• Click the Paste Field Tool ( ) on the Land Unit Editor Toolbar. 
• Select Save Edits from the Editor Menu on the Land Unit Editor Toolbar.  

• Once the copies to field boundaries (a.k.a. PLU layer) are complete, select Stop Editing from the 
Editor Menu on the Land Unit Editor Toolbar. If prompted to save edits, choose Yes.   
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Labeling a PLU Layer in ArcGIS: 
 
• The Planned Land Units theme MUST BE ATTRIBUTED before you can use this tool. 

• Click on Map Labels ( ). 
• Select the PLU layer name from the Select Layer pull-down menu. Note: If you have saved User 

Preferences from a previous customer, click the User Preferences Button to reload those settings. 

• Check the Create Annotation checkbox. 

• Select desired style (text, bullet leader, or callout) from the Label Style pull-down menu.  

• Check the Scale Labels checkbox. 

• In the Label Description section check the checkbox for the first line, select Land Unit Number from 
the Field pull-down menu and type “Field” in the textbox to the right. 

• In the Label Description section check the checkbox for the second line, select Land Unit Acres 
from the Field pull-down menu, select AC from the Units pull-down menu and use the arrow buttons 
in the Decimals column to set the number of decimal places to 1. 

• In the Label Description section check the checkbox for the third line, select NRCS Land Use from 
the Field pull-down menu. 

• Note: If this is the first time you have created PLU labels in Toolkit, click the Save User Preferences 
Button to save these settings for future use.   

• Click the OK Button on the Map Labels Window.  Click the OK Button on the Annotation Layer 
Name Window to accept the current layer name (or change the name then click the OK Button). 

• The new annotation layer should be added to the Data View.  Use the Pointer Tool ( ) on the 
Drawing Toolbar ( ) to select (and move) the label(s) as needed. Use the Drawing Toolbar 
functions (e.g. font type, size, style, color) to modify the selected label(s) as needed. 

• Tip: To change a text label(s) to a callout label, double left-click on the label using the Pointer Tool, 
click on the Change Symbols Button (on the Text Tab) and in the Symbol Selector Window scroll 
to the bottom and select Banner Text, click OK to close the Symbol Selector Window and OK to 
close the Label Properties Window. Use the Pointer Tool to move the label(s) and the Drawing 
Toolbar functions to modify the label(s). 

• Tip: To delete a label, select it using the Pointer Tool, right click and select Delete.  

 
Labeling a Roads Layer in ArcGIS: 
 
• In the Table of Contents (TOC), left click and hold on the Roads Layer and drag it to the top of the 

TOC. 

• Select the Label Button ( ) from the Text Menu ( ) on the Drawing Toolbar.   
• Select Place at position clicked on the Label Options Window and close the window.  

• Left click on the desired road(s) to produce the label(s).  
• Note: Sometimes the label does not appear to follow the angle of the road. Take the Pointer Tool and 

double click on the Label then click OK to close the Label Properties Window.  This should adjust the 
label angle to the road. If necessary use the Rotate Button (on the Drawing Toolbar) to adjust the 
angle. 
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Alternative Labeling Method in ArcGIS (Converting Labels to Annotation): 
 
These instructions describe how to label any layer (e.g. soils map, resource inventory, etc.) using the 
Label Features/Convert Labels to Annotation function. 

• Note: Map labels are for quick display in ArcGIS and cannot be manipulated like annotation layers. 
• Note: To change the label value for the Label Features function, right click on the desired layer and 

select Properties. In the Layer Properties Window click on the Labels Tab. In the Text String 
Section, use the pull-down menu for Label Field to select the desired label  field. Click the OK 
Button. 

• In the Table of Contents right-click on the layer you wish to label and select Label Features. This 
will create map labels for your layer.   

• In the Table of Contents right-click on the same layer and select Convert Labels to Annotation.  
• In the Convert Labels to Annotation Window, click on the Features Displayed in Current Extent 

option (in the Create Annotations for: Section).   
• In the Annotation Storage Options Section make sure In the Map is selected. 
• Take the default Annotation Group Name or click in the textbox and enter a new name (if desired).  
• Click the OK Button. 
• The new annotation layer should be added to the Data View.  Use the Pointer Tool ( ) on the 

Drawing Toolbar ( ) to select (and move) a label(s) as needed. Use the Drawing Toolbar 
functions (e.g. font type, size, style, color) to modify the selected label(s) as needed. 

• Tip: To change a text label(s) to a callout label, double click on the label using the Pointer Tool, click 
on the Change Symbols Button (on the Text Tab) and in the Symbol Selector Window scroll to 
the bottom and select Banner Text, click OK to close the Symbol Selector Window and OK to 

• Note: Do not delete or turn off the Default Annotation Group Layer. 
 
 
Turn Off/On an Annotation (a.k.a. Labels) Layer in ArcGIS: 
 
• Double left-click on the Data Frame (named “Layer”  - ) in the Table of Contents.  
• Click on the Annotation Groups Tab in the Data Frame Properties Window. 
• Click on the checkbox next to the desired Annotation Group to turn on/off.  
• Click OK Button to close the Data Frame Properties Window. 
• Note: Do not delete or turn off the Default Annotation Group Layer. 
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Create a New Practice Layer (Point, Line or Polygon) in ArcGIS: 
 
Practices Layers are created to show the location of structural practices (planned or applied) on the map.  
When creating a practice layer you must decide what type of map feature to use (point, line or polygon).  
Use the practice’s unit of measure to help decide which type of map feature to use.  For example, fence is 
measured in feet thus it would be created as a practice line layer.   

• Click on Create New Layer ( ). 

• Under the Practice Section select the type of layer to be created and click the OK Button. 
• The new layer is added to the Table of Contents in Edit mode and the appropriate digitizing toolbar 

(point, line or polygon) is displayed.  
• Note: If the Practice Editor Toolbar is accidentally closed it can be retrieved by clicking the 

Digitizing Button ( ). 
Practice Point 

• Select the Add Practice Tool (  ) 
• Place you cursor at the location of the point and left click to digitize the point. Repeat above step (as 

needed) until all the practice points have been digitized. 

• Note: If you misplace a point use the Undo Edit Button to remove the point or use the Select 
Practice Tool ( ) to select the point then use the Edit Tool ( ) to relocate it or press the Delete 
key on the keyboard to remove it.  

• Select Stop Editing from the Editor Menu and save edits. 

• Click on the Attribute Tool ( ). 
• In the Attribute Tool Window select Practice (Points) from the Select Layer pull-down menu. 

• In the Data View, left click on the first practice point to attribute. Complete the information in the 
Attribute Tool Window and click the Apply Button. 

• Repeat the above step until all practice points have been attributed. 

• When complete, click the OK Button to close the Attribute Tool Window. 
Practice Line 

• Select the Add Practice Tool (  ) 
• Place you cursor at the starting point and left click to start digitizing the line. Left click (one time) at 

every turning point.  Continue until the line feature is complete and double left-click. Note: If you 
double left-click and the digitizer does not stop, right click and select Finish Sketch. 

• Repeat the above step until all practice lines have been completed. 

• Note: If you misplace a line use the Undo Edit Button to remove the line or use the Select Practice 
Tool ( ) to select the line and press the Delete key on the keyboard to remove it.  

• Note: If a line practice crosses into more than one field, the Split Practice Tool (  ) can be used to 
split a practice line into two or more separate practices. Note: First select the line to be split using the 
Select Practice Tool ( ). 

• Select Stop Editing from the Editor Menu and save edits. 

• Click on the Attribute Tool ( ). 
• In the Attribute Tool Window select Practice (Lines) from the Select Layer pull-down menu. 

• In the Data View, left click on the first practice point to attribute. Complete the information in the 
Attribute Tool Window and click the Apply Button. 

• Repeat the above step until all practice lines have been attributed. 

• When complete, click the OK Button to close the Attribute Tool Window. 
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Create a New Practice Layer (Point, Line or Polygon) in ArcGIS (cont.): 
 
Practice Polygon 
• Note: You will want to add agronomic or management-type practices (e.g. Conservation Crop 

Rotation, Pest Management etc.) manually in the Practice Scheduler 
• Select the Add Practice Tool (  ) 
• Place your cursor at the starting point and left click to start digitizing the polygon. Move the cursor to 

the next point and left click.  Repeat this process until the second to last point (next point being the 
starting point) and double left-click to close the polygon boundary. 

• Note: It is not necessary to return to the beginning point of the field to close the polygon boundary. 
Toolkit will automatically close the polygon.  

• Repeat the above steps for until all practice polygons have been completed. 

• Note: If you misplace a polygon use the Undo Edit Button to remove the polygon or use the Select 
Practice Tool ( ) to select the polygon and press the Delete key on the keyboard to remove it. 

• Select Stop Editing from the Editor Menu and save edits. 

• Click on the Attribute Tool ( ). 
• In the Attribute Tool Window select Practice (Polygons) from the Select Layer pull-down menu. 

• In the Data View, left click on the first practice polygon to attribute. Complete the information in the 
Attribute Tool Window and click the Apply Button. 

• Repeat the above step until all practice polygons have been attributed. 

• When complete, click the OK Button to close the Attribute Tool Window. 
 
Copy and Paste Tools for Practice Points, Lines and Polygons 
• Note: This tool is used to copy features from another layer (GPS data shapefile, Resource Inventory, 

Build Your Own Polygon, etc.) into a Practice layer. It has been included in the New Practice Layer 
Section but could also be used in when editing a practice layer. 

• Note: The practice layer must be in Edit mode. If the Practice Editor Toolbar is accidentally closed it 
can be retrieved by clicking the Digitizing Button ( ). 

• Turn off (uncheck) all other layers except the “copy from” layer, the desired practice layer (point, line 
or polygon) and photography layer.  

• In the Table of Contents (where the layer names are listed) left click (one time) on the “copy from” 
layer name (it will highlight dark blue). 

• Use the Select Tool ( ) on the ArcGIS Toolbar (not the Land Unit Editor Toolbar) and click on 
the features (point, line or polygon) to copy (hold the shift key down to select more than one feature). 

• Click the Copy Tool ( ) on the Practice Editor Toolbar. 
• In the Table of Contents (where the layer names are listed) left click (one time) on the practice layer 

name (it will highlight dark blue). 

• Click the Paste Tool ( ) on the Practice Editor Toolbar. 
• Select Save Edits from the Editor Menu on the Practice Editor Toolbar.  

• Once the copies are complete, select Stop Editing from the Editor Menu on the Practice Editor 
Toolbar. If prompted to save edits, choose Yes.   
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Edit or Add to a Practice Layer (Point, Line or Polygon) in ArcGIS: 
 
These instructions describe how to perform additional edits on a practice layer. 

• Note: To start editing a practice (resource inventory or build your own) layer that is not in Edit Mode 
click the Toolkit Digitizer ( ) and select the practice (resource inventory or build your own) layer 
name from the Select a Layer to Edit Window. 

• Note: If the Practice Editor Toolbar is accidentally closed it can be retrieved by clicking the 
Digitizing Button ( ). 

• Note: Additional practices and in some cases, altered practices need to be attributed. 
• Note: If the practice layer has already been symbolized, open the Symbology Tab for the practice 

layer and click the checkbox for All Other Values, close the Symbology Window and begin editing. 
 
Practice Point 
• To move a point, select the point using the Select Practice Tool ( ) on the Point Editor Toolbar. 

Click on the Edit Tool ( ) move it over the selected point (four-way arrow appears) left click and 
hold. Move the point to the desired location and release the left click. 

• To add an additional point, use the Add Practice Tool. 
• To delete a point, select the point using the Select Practice Tool ( ) on the Point Editor Toolbar 

and press the Delete Key on the keyboard. 
• Select Stop Editing from the Editor Menu and save edits.  
 
Practice Line 

• To add an additional line practice, select the Add Practice Tool (  ). Digitize the new line. 

• Select Stop Editing from the Editor Menu and save edits. 

• To edit the vertices of existing line practice, select the line using the Select Practice Tool ( ) on the 
Line Editor Toolbar.  

• Click the Edit Vertices Tool ( ). The vertices for the selected line will appear (green squares).  
• To move a vertex, place the cursor over the vertex, left click and hold then drag and drop in the new 

location. Repeat this process until complete then stop editing. 
• To delete a vertex, place the cursor over the vertex, right click and select Delete. Repeat this 

process until complete then stop editing. 
• To insert a vertex, place the cursor over new vertex location, right click and select Insert Vertex. 

Repeat this process until complete then stop editing. 
• Once the vertex edits are complete, select Stop Editing from the Editor Menu and save edits.  

• To reshape an existing line practice, select the line using the Select Practice Tool ( ) on the Line 
Editor Toolbar.  

• Click the Reshape Practice Tool ( ).   
• Click outside the line you want to reshape, cross the line, and left click at each turning point. Continue 

until crossing the line a second time and double left-click to complete the reshape.  
• Once the reshaping is complete, select Stop Editing from the Editor Menu and save edits.  
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Edit or Add to a Practice Layer (Point, Line or Polygon) in ArcGIS (cont.): 
 
Practice Polygon 

• To add an additional polygon practice, select the Add Practice Tool (  ). Digitize the new polygon. 

• Select Stop Editing from the Editor Menu and save edits. 
• To edit the vertices of existing polygon practice, select the polygon using the Select Practice Tool 

( ) on the Polygon Editor Toolbar.  

• Click the Edit Vertices Tool ( ). The vertices for the selected edge will appear (green squares).  
• To move a vertex, place the cursor over the vertex, left click and hold then drag and drop in the new 

location. Repeat this process until complete then stop editing. 
• To delete a vertex, place the cursor over the vertex, right click and select Delete. Repeat this 

process until complete then stop editing. 
• To insert a vertex, place the cursor over new vertex location, right click and select Insert Vertex. 

Repeat this process until complete then stop editing. 
• Once the vertex edits are complete, select Stop Editing from the Editor Menu and save edits.  

• To reshape an existing polygon practice, select the polygon using the Select Practice Tool ( ) on 
the Polygon Editor Toolbar.  

• Click the Reshape Practice Tool ( ).   
• Left click outside the boundary of the polygon you want to reshape, cross the boundary, and left click 

at each turning point. Continue until crossing the boundary a second time and double left-click to 
complete the reshape.  

• Once the reshaping is complete, select Stop Editing from the Editor Menu and save edits.   

• Note: For the Split Field Tool to work, a polygon must be selected.  
• To split an existing polygon practice, select the polygon using the Select Field Tool ( ) on the 

Polygon Editor Toolbar.   
• Select the Split Practice Tool (  ).   
• Move the cursor to the start location (outside of the polygon boundary) then left click (one time) to 

start drawing.  Left click (one time) at each turning point.  Continue until crossing a second boundary, 
then double left-click.  The new polygon boundary will be snapped to the existing polygon boundary 
and the excess lines will be clipped off.  

• Note:  For the Split Field Tool to work, you need to cross at least 2 polygon boundaries. 
• Once the splits are complete, select Stop Editing from the Editor Menu and save edits. 

 
 
 
 
 
 
 
 
 
 
 
 
 



 21

Create a New Resource Inventory Layer (Point, Line or Polygon) in ArcGIS:  
 
Resource Inventory Layers are created to show the location of existing features (e.g. sink hole, well, 
power line, transect, underground cable, ditch, resource concern, etc.) on the map.  The first step is to 
decide the type of map feature (point, line or polygon). The process of creating a new Resource Inventory 
Layer are the same used for creating a new Practice Layer (point, line or polygon).  

• Click on Create New Layer ( ). 

• Under the Resource Inventory Section select the type of layer to be created. 
• Enter the Layer Name and change the file name (as needed) then click the OK Button. 
• Tip: To change the shapefile name for a resource inventory layer you must click in the File Name 

textbox containing the filename, manually delete the filename and type in a new one. You do not 
need to type the “.shp” at the end of the file name. Toolkit will automatically add this file extension. 

• The new layer is added to the Table of Contents in Edit mode and the appropriate digitizing toolbar 
(point, line or polygon) is displayed.  

 
Resource Inventory Point 
• Refer to Practice Point Section of Create a New Practice Layer in ArcGIS for point creation 

procedures. 
 
Resource Inventory Line 
• Refer to Practice Line Section of Create a New Practice Layer in ArcGIS for line creation 

procedures. 
 
Resource Inventory Polygon 

• Note: The Add Circle Tool ( ) is a tool that is available for Resource Inventory and Build Your Own 
Polygon Layers only. It is not referenced in the Practice Polygon sections of these notes. To operate, 
left click the tool, move the cursor to the circle’s center location. Left click and move the cursor to 
create the circle.  Double left click when the desired perimeter of the circle is reached. 

• Refer to Practice Polygon Section of Create a New Practice Layer in ArcGIS for non-circular 
polygon creation procedures. 

• Click on the Attribute Tool ( ). 
• In the Attribute Tool Window select the new resource inventory layer name from the Select Layer 

pull-down menu. 

• In the Data View, left click on the resource inventory feature to attribute. Complete the information in 
the Attribute Tool Window and click the Apply Button. 

• Repeat the above step until all the resource inventory features have been attributed. 

• When complete, click the OK Button to close the Attribute Tool Window. 
 
Edit or Add to a Resource Inventory Layer (Point, Line or Polygon) in ArcGIS: 
 
The general process of editing or adding to a Resource Inventory Layer (point, line or polygon) is the 
same used for editing or adding to a Practice Layer (point, line or polygon). Refer to Edit or Add to a 
Practice Layer (Point, Line or Polygon) in ArcGIS Section for editing procedures. 
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Create a Build Your Own Layer (Point, Line or Polygon) in ArcGIS:  
 
Build Your Own Layers are created to show the location of any non-resource inventory or practice feature 
on the map.  The first step is to decide the type of map feature (point, line or polygon). The process of 
creating a new Build Your Own Layer are the same used for creating a new Practice (point, line or 
polygon) or Resource Inventory Layer (point, line or polygon).  

• Click on Create New Layer ( ). 

• Under the Build Your Own Section select the type of layer to be created. 
• Enter the Layer Name and change the file name (as needed) then click the OK Button. 
• Tip: To change the shapefile name for a build your own layer you must click in the File Name textbox 

containing the filename, manually delete the filename and type in a new one. You do not need to type 
the “.shp” at the end of the file name. Toolkit will automatically add this file extension. 

• The new layer is added to the view in Edit mode and the appropriate digitizing toolbar (point, line or 
polygon) is displayed.  

• Note: The Attribute Tool ( ) does not work on Build Your Own Layers. 
 
Build Your Own Point 
• Refer to Practice Point Section of Create a New Practice Layer in ArcGIS for point creation 

procedures. 
 
Build Your Own Line 
• Refer to Practice Line Section of Create a New Practice Layer in ArcGIS for line creation 

procedures. 
 
Build Your Own Polygon 

• Note: The Add Circle Tool ( ) is a tool that is available for Resource Inventory and Build Your Own 
Polygon Layers only. It is not referenced in the Practice Polygon sections of these notes. To operate, 
left click the tool, move the cursor to the circle’s center location. Left click and move the cursor to 
create the circle.  Double left click when the desired perimeter of the circle is reached. 

• Refer to Practice Polygon Section of Create a New Practice Layer in ArcGIS for polygon creation 
procedures. 

 
Edit or Add to a Build Your Own Layer (Point, Line or Polygon) in ArcGIS: 
 
The general process of editing or adding to a Build Your Own Layer (point, line or polygon) is the same 
used for editing or adding to a Practice (point, line or polygon) or Resource Inventory Layer (point, line or 
polygon). Refer to Edit or Add to a Practice Layer (Point, Line or Polygon) in ArcGIS Section for 
editing procedures. 
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Create a Buffer Layer in ArcGIS: 
 
• In the Table of Contents, turn off (uncheck) all other layers except the layer to be buffered and 

photography layer.  
• Use the Select Tool ( ) on the ArcGIS Toolbar (not the Land Unit Editor Toolbar) and click on 

the feature(s) to buffer (hold the shift key down to select more than one feature). 

• Click the Buffer Tool (  ). 
• In the Create Buffer Window, click The Features of Layer radio button and use the pull-down menu 

to select name of the layer you wish to buffer then click the Next Button. 
• Enter the buffer width and select the correct units (e.g. feet) using the pull-down menu. 
• Select the buffer type (e.g. inside, outside, etc.). Use the preview window to the right to see the 

results of your selection.  
• Note: One sided buffers function for line layers uses the line drawing direction to determine right and 

left. For example if the line was drawn from south to north then the “right side” of the line would be the 
eastern side and the “left side” of the line would be the western side. 

• Select the appropriate output (in a graphics layer, and existing layer or a new shapefile layer) in the 
Where do you want the buffers to be saved? Section. Note: if the buffer is going to be a practice, 
you will probably want to save it in your existing Practice (Polygons) layer. New shapefile buffer 
layers are not attributable. 

• Tip: To change the shapefile name for a new buffer layer you must click in the File Name textbox 
containing the filename, manually delete the filename and type in a new one. You do not need to type 
the “.shp” at the end of the file name. Toolkit will automatically add this file extension. 

• Click the Finish Button. 
• Note: In some cases, parts of the buffer may need to be changed. In these cases, start editing the 

layer containing the buffer. To start editing click the Toolkit Digitizer ( ) and select appropriate 
layer name from the Select a Layer to Edit Window. Then refer to the Edit or Add to a Practice 
Layer (Point, Line or Polygon) in ArcGIS Section. 

• Note: Newly created practice buffers will need to be attributed using the Attribute Tool. 

 
Create a Soils Layer in ArcGIS:   
 
Soils layers can be created for any polygons layers (PLU, Buffer, Practice, etc.). The general process is 
the same.  These instructions refer to creating a soils layer using the PLU layer. 

• Click the Soils Map Button ( ). 

• Select the desired layer (PLU layer name) from the Selected Layer pull-down menu.  

• Click the Browse Button to the right of the File Name and enter an appropriate file name. Note: It is 
strongly recommended to use the tract (or farm) number as part of the filename (e.g. 
T1428_soils_map.shp) 

• Check the appropriate output options in the Soils Inventory Report Display Options Section. 

• Click the OK Button. The soils inventory report will be displayed first. Print and/or close the window 
(as needed). Note: The soils inventory report will automatically be saved to the customer folder in the 
Resource Maps subfolder. 

• Double left-click on the polygon symbol for the Soils Map Layer in the Table of Contents. In the 
Symbol Selector Window, select Hollow and adjust outline width and color then click the OK 
Button. 

• Note: Soils layers can also be symbolized with cross-hatching and transparent fills. Refer to 
Changing Symbols in ArcGIS Section for general symbolizing procedures. 
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Labeling Practice, Resource Inventory and Soils Layers in ArcGIS: 
 
There are a variety of ways to create labels (a.k.a. annotation) in ArcGIS. For another labeling method 
see Alternative Labeling Method in ArcGIS (Converting Labels to Annotation 
 

Note: Use the Pointer Tool ( ) on the Drawing Toolbar to select (and move) a label(s). Use the 
Drawing Toolbar functions to modify (e.g. font type, size, style, color) the selected label(s). 

Tip: To change a text label(s) to a callout label, double click on the label using the Pointer Tool, click on 
the Change Symbols Button (on the Text Tab) and in the Symbol Selector Window scroll to the 
bottom and select Banner Text, click the OK to close the Symbol Selector Window and OK to close the 
Label Properties Window. Use the Pointer Tool to move the label(s) and the Drawing Toolbar 
functions to modify the label(s). 
Tip: To delete a label, select it using the Pointer Tool, right click and select Delete.  
Practice Labels 

• Click Map Labels (  ). 
• Select the Practice layer name from the Select Layer pull-down menu. Check the Create 

Annotation checkbox. 

• Select desired style (text, bullet leader, or callout) from the Label Style pull-down menu.  

• Check the Scale Labels checkbox. 

• In the Label Description section check the checkbox for the first line, select Practice Name from the 
Field pull-down menu. 

• Click the OK Button on the Map Labels Window.  Click OK Button on the Annotation Layer Name 
Window to accept the current layer name (or change the name and then click the OK Button). 

 
Resource Inventory Labels 

• Click Map Labels (  ). 
• Select the Resource Inventory layer name from the Select Layer pull-down menu. Check the Create 

Annotation checkbox. 

• Select desired style (text, bullet leader, or callout) from the Label Style pull-down menu.  

• Check the Scale Labels checkbox. 

• In the Label Description section check the checkbox for the first line, select Type or Label 
(depending on what attribute information was entered) from the Field pull-down menu. 

• Click the OK Button on the Map Labels Window.  Click OK Button on the Annotation Layer Name 
Window to accept the current layer name (or change the name and then click the OK Button). 

 
Soils Map Labels 

• Click Map Labels (  ). 
• Select the Soils Map layer name from the Select Layer pull-down menu. Check the Create 

Annotation checkbox. 

• Select desired style (text, bullet leader, or callout) from the Label Style pull-down menu.  

• Check the Scale Labels checkbox. 

• In the Label Description section check the checkbox for the first line, select Musym from the Field 
pull-down menu. 

• Click the OK Button on the Map Labels Window.  Click OK Button on the Annotation Layer Name 
Window to accept the current layer name (or change the name and then click the OK Button). 

• Note: Sometimes because of the way the soils map is created, there are many excess labels. Delete 
the excess labels as needed. 
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Change Symbology for a Layer in ArcGIS: 
 
There are two situations releated to symbology in ArcGIS. The first is a layer where all the features are 
the same symbol (e.g. PLU layer). The second is a layer where different feature types have different 
symbols (e.g. Practice layer). Note: Practice Layers should be Attributed before changing their symbols. 
Single Symbols 
• Double left-click on the layer symbol (located under the layer name) in the Table of Contents. 
• In the Symbol Selector Window, left click to select the desired symbol. A preview of the symbol will 

display in the upper right-hand corner. 
• Note: If the NRCS Planning Symbols are not present or you want additional styles of symbols, left 

click on the More Symbols Button and select the desired symbol theme. 
• Use the Options Section to adjust the symbol properties (e.g. fill color, outline color, outline width, 

line color and width, and point size, color and angle) then click the OK Button. 
• Once a layer has been symbolized, right click on the layer name in the Table of Contents and select 

Save Symbology. 
Unique Value Symbols 
• Double left-click on the layer name in the Table of Contents. 
• Click on the Symbology Tab in the Layer Properties Window 
• Click on Categories. Use the pull-down menu and select the correct value under the Value Field (for 

a Practice Layer select Practice Name for a Resource Inventory select PolyType or Label 
(depending on what attribute information was entered for the features), for a Soils Layer select 
Musym). 

• Uncheck the All Other Values checkbox and click the Add All Values Button. Tip: When editing a 
previously symbolized layer, be sure to check the All Other Values checkbox until edits and 
attributing is complete. Then uncheck for map production. 

• Optional: In the Label Column a bold text header will be displayed (e.g. Practice Name). Click on the 
bolded header name and delete/backspace over the header. 

• Double left-click on the symbol in the Symbol Column for the feature. 
• In the Symbol Selector Window, left click to select the desired symbol. A preview of the symbol will 

display in the upper right-hand corner. 
• Tip: Some Fill Symbols have foreground and background colors. To access and change a symbol’s 

foreground and background colors, click on the Properties Button in the Symbol Selector Window. 
• Use the Options Section to adjust the symbol properties (e.g. fill color, outline color, outline width, 

line color and width, and point size, color and angle) then click the OK Button. 
• Repeat the last three steps until all the symbols have been symbolized for that layer. When complete 

click the OK Button to close the Layer Properties Window. 
• Once a layer has been symbolized, right click on the layer name in the Table of Contents and select 

Save Symbology. 
Changing Layer Names 
• Left click (one time) on the layer name in the Table of Contents to select it. Left click again to unlock 

the layer name and type in the new layer name and press Enter. Note: The layer name is the name 
that appears in the map legend. 

Setting Transparency 
• Double left-click on the layer name in the Table of Contents. 
• Click on the Display Tab in the Layer Properties Window. 
• Click in the Transparency textbox and enter the percent transparency for that layer. 
• Click the OK Button to close the Layer Properties Window. 
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Change Symbology Using Toolkit Stylesheet for a Practice Layer in ArcGIS: 
 
The Toolkit Practice stylesheet was setup to assist Toolkit users with the symbolization of Toolkit Practice 
Layers where features have different types symbols. Note: Practice Layers should be Attributed before 
changing their symbols. 
Loading Symbols for Unique Value - Practice Features 
• Double left-click on the layer name in the Table of Contents. 
• Click on the Symbology Tab in the Layer Properties Window 
• Click on Categories. Under Categories left click on Match to symbols in a style.   
• Use the pull-down menu under the Value Field and select Practice Name. 
• Use the pull-down menu under Match to symbols in a style and select 

NRCS_Toolkit5_Practice_Styles.style.  Note: The style sheet name can be changed or even saved 
under the user’s own personal stylesheet. 

• Uncheck the All Other Values checkbox and click the Match Symbols Button. Tip: When editing a 
previously symbolized layer be sure to check the All Other Values checkbox until edits and 
attributing is complete. Then uncheck for map production. 

• Optional: In the Label Column a bold text header will be displayed (e.g. Practice Name). Click on 
the bolded label and delete/backspace over the header. 

• Optional: To change any of the stylesheet symbols, double click on the symbol in the Symbol 
Column for a feature. In the Symbol Selector Window, left click to select the desired symbol. A 
preview of the symbol will display in the upper right-hand corner. Use the Options Section to adjust 
the symbol properties (e.g. fill color, outline color, outline width, line color and width, and point size, 
color and angle) then click the OK Button.  Repeat this step until all desired changes have been 
made. 

• Tip: Some Fill Symbols have foreground and background colors. To access and change a symbol’s 
foreground and background colors, click on the Properties Button in the Symbol Selector Window. 

• When complete click the OK Button to close the Layer Properties Window. 
• Once a layer has been symbolized, right click on the layer name in the Table of Contents and select 

Save Symbology. 
Customizing the Stylesheet 
The Toolkit stylesheet can be modified (before or after distribution) as needed. Note: The style sheet can 
be modified while in a Toolkit map document or from a separate non-Toolkit session of ArcMap. 

• From the Tools Menu, select Styles and choose Style Manager. 
• Click the Styles Button and make sure the NRCS_Toolkit5_Practice_Styles.style stylesheet is 

selected.  The contents of the stylesheet will be displayed on the left-hand side. 

• Click the plus button to expand the contents of the stylesheet. Click on the folder of the desired 
category of symbol you wish to modify (Fill, Line or Marker Symbols). The symbols should appear on 
the right hand side of the Style Manager Window. 

• Locate the symbol you wish to change and double left click on the symbol. Make desired changes in 
the Symbol Property Editor Window and click the OK Button to accept the change. Repeat this 
process to change any Fill, Line or Marker Symbols. 

• When all the changes are complete, click the Close Button and the changes will be saved. Note: 
Changes made on one computer do not affect the stylesheets on other computers. If the changes are 
desired on each computer in an office or state, the stylesheet should be modified first and then copied 
to all desired computers. 
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Change Symbology Using Toolkit Stylesheet for a Practice Layer in ArcGIS 
(cont.): 
 
Copying Symbols into a User’s Personal Stylesheet 
The Toolkit Practice stylesheet can be copied into a user’s personal stylesheet. Note: A user’s personal 
stylesheet is loaded by default when a user starts ArcMap (inside or outside Toolkit). The stylesheet is 
named after the user login (firstname.lastname.style) and is stored in C:\Documents and 
Setting\<user_name>\Application Data\ESRI\ArcMap. 
Note: The style sheet can be modified while in a Toolkit map document or from a separate non-Toolkit 
session of ArcMap. 

• From the Tools Menu, select Styles and choose Style Manager.  
• Click the Styles Button and make sure the NRCS_Toolkit5_Practice_Styles.style stylesheet is 

selected.  The contents of the stylesheet will be displayed on the left-hand side. 

• Click the plus button to expand the contents of the stylesheet. Click on the folder of the desired 
category of symbol you wish to modify (Fill, Line or Marker Symbols). The symbols should appear on 
the right hand side of the Style Manager Window. 

• Using the CTRL or Shift Keys select the desired symbols from the right-hand side of the Style 
Manager Window. Once selected, right click on the selected symbols and select Copy. 

• Click the plus button to expand the contents of the user’s personal stylesheet. Click on the folder of 
the same category of symbols you wish to paste to (Fill, Line or Marker Symbols). On the right-hand 
side, right click and select Paste. The symbols should be copied into your personal stylesheet. 
Repeat this process as needed. 

• Follow the instructions above for customizing a personal stylesheet. Substitute your personal 
stylesheet name in the instructions for the NRCS_Toolkit5_Practice_Styles.style stylesheet. 

• When all the copies are complete, click the Close Button and the changes will be saved. Note: 
Changes made on one computer do not affect the stylesheets on other computers. If the changes are 
desired on each computer in an office or state, the stylesheet should be modified first and then copied 
to all desired computers. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 28

Map Production and Development in ArcGIS:   
 

•     After you have created, labeled and symbolized all necessary data, click on Map Products (  ).  
• Under the Heading Tab (in the Map Products Window) click the checkboxes next to each map 

layout component (e.g. map title, customer name, field office etc.) to appear in your map. Enter the 
desired information in each textbox or use the pull-down menus to select previously entered text.   

• Click the Layout and Scale Tab and select the paper size/layout and scale. Tip: To choose a scale 
not listed, select User Defined and enter the scale in the textbox to the right. This option also sets 
your scale bar units so you do not have to adjust them manually. 

• Click the Apply Button. Move the Map Products Window to the side and make sure the map fits 
correctly in the Data Frame. If it does not, change the scale until it fits correctly. 

• Once you have an appropriate scale click the OK Button. Answer No to save your work (it will be 
saved after final edits have been made). 

• To navigate around the map layout use the Layout Tool Bar ( ) 

• Use the Pointer Tool ( ) on the Drawing Toolbar to select, move and resize all map layout 
components. Use the Drawing Toolbar functions to modify (e.g. font type, size, style, color) a 
selected map component.  

• Tip: When trying to select a map layout component, the first item always selected is the map neatline. 
Thus, the user must left click a second time while their cursor is over the desired map layout 
component (Selected items have a blue dashed line and boxes around them).To move a selected 
item left click and hold then drag and drop the object to its desired position. To resize a selected 
object, move the cursor over one of the blue boxes and your Pointer Tool will become a 2-way 
diagonal arrow. Left click and hold then drag in the desired direction. 

• Tip: To reduce the size of your legend: 1)Try turning off all unessential layers (especially the Base 
Layer) in the Table of Contents, 2) Reduce the legend font size, and 3)Move the Data Frame 
towards the top of the page. 

• Tip: To delete a component, select it and right click to choose Delete. 
• Tip: To change existing text, select it, right click to choose Properties and modify the text. 

• Tip: To manually change the scale bar, select it, right click to choose Properties. In the Scale Bar 
Properties Window click on the Scale and Units Tab and modify the text. Select Adjust Width from 
the When Resizing pull-down menu. Enter the correct division value in the Division Value textbox. 
Adjust Number of Divisions and Number of Subdivisions as needed. Click the OK Button. 

• Tip: Frequently an Image Legend is listed below the Layer Legend. If this cannot be deleted, cover it 
with the Layer Legend or move it off of the printable page area. 

• When all adjustments to the map layout are complete. Click on Save Work ( ).  Enter a new 
filename in the Export to PDF Window. Note: It is strongly recommended to use the tract (or farm) 
number and program name for the filename (e.g. T1428_EQIP.pdf).  Include “soils” for a soils map 
(e.g. T1428_EQIP_soils.pdf). 

• Select Print from the ArcGIS File Menu. 

• Tip: To move between the Data View and the Layout View use the View Menu or the short cut 
buttons ( ). 
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Develop a Conservation Plan:  
 
These instructions are for developing a plan after a map has been created. To create a plan without using 
ArcGIS, refer to Operating Toolkit without ArcGIS Section. 
 
• Close your ArcGIS map document. 
• On the Toolkit Framework click on the Practice Scheduler Tab. 
• Select the conservation plan database from the Land Units Section pull-down menu. 
• Note: You will want to add agronomic-type practices (e.g. Conservation Crop Rotation, Pest 

Management, etc.) manually in the Practice Scheduler. 
• Click the plus sign ( ) next to the tract number to display all the land units for a particular tract(s). 
• Click the checkboxes next to the land units to be included in the conservation plan.  
• Note: To add additional practices not captured in ArcGIS, follow practice scheduling steps for 

Operating Toolkit Without ArcGIS. 
• Select appropriate narratives for each practice, edit planned amounts (as needed) and select the 

correct cost share program. 
• Once all information is complete, click the Save As Button. 
• Click the Plan Wizard Button. 
• In the Conservation Plan Wizard Window, select the appropriate template and land use category. 
• Click Next Button to continue. 
• By default the current customer will be added in the Select Participants Window. If you have an 

Associated Customer click the List of Participants pull-down menu, select the customer and click the 
Add Button.  The customer’s name is added to the bottom of the screen.   

• Note: You can also manually add a participant by manually typing in the customer information and 
clicking the Add Button.    

• To remove a participant, select a person from the bottom list and press the Delete Key.   
• Click the Next Button to continue. 
• Set preferences and change signature box information (as needed). 
• Known Bug: A known bugs exist in the Plan Wizard. To help avoid this bug be sure not to 

select the Sort by Practice option and the Consolidate Recurring Practices option at the same 
time. These two options selected together will double some land unit acreages in the plan 
document.  

• Add Standard Statements or Objectives (as needed). 
• Click the Finish Button. 
• Enter a filename in the Save As Window.  Note: It is strongly recommended to use the tract (or farm) 

number and program name for the filename (e.g. T1428_EQIP.xls).  
• Click Open Button to save the file. 
• Check to be certain the plan is complete and accurate. When you are satisfied with the plan, select 

Print Preview from the File Menu. 
• In the Print Preview Window, click the Page Break Preview Button at the top of the window.  This 

will display your document with the current page breaks represented by dashed blue lines.  Be certain 
the page breaks are in an appropriate position.  If a page break is splitting a narrative, table or 
signature block, you may wish to move the page break.  To move the page break, place your cursor 
over the blue line.  Your cursor will turn into a double arrow line.  When it does, left click and hold to 
gain control of the page break.  Then move the page break to a more appropriate position.  Repeat 
this process as needed. 

• To return to the previous view, select Normal from the View Menu. 
• Select Save from the File Menu. 
• Select Print from the File Menu to print your document. 
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Develop a Contract Support Document:   
 
These instructions are for developing a contract support document after a map and plan have been 
created. To create a contract support document without using ArcGIS, refer to Operating Toolkit without 
ArcGIS Section. 
 
• Note:  Before developing contract, be certain your cost lists are current and accurate. 
• Tip: For EQIP and WHIP contracts, select only cost shared practices for the Contract Wizard. To do 

this, use a click and Shift or Ctrl Key to select only the cost shared items in the Schedule Section. 
• After you have scheduled and saved the practices, click the Contract Wizard Button.  
• In the Contract Wizard Window, select the appropriate contract template. 
• Enter the filename of your contract in the Contract Identifier textbox.  Note: It is strongly 

recommended to use the tract (or farm) number and program name for the Contract Identifier 
because this will ultimately be the contract support document filename (e.g. T1428_EQIP.xls).  

• Double left-click on Click to Select a Cost List then double left-click the correct cost list to select it. 
• Click the Next button to display the Components Window. 
• Click on the plus sign located to the left of the practice code(s). Then click on the plus sign to the left 

of the Tract Number.  All scheduled land units will be displayed. 
• For cost shared practices, click the land unit and the practice component(s) will be listed to the right. 

For non-cost shared practices, click on the dollar sign and a red strike will be placed through it.  
Then click the checkbox to the left of the land unit with the non-cost shared practice. 

• To select a component(s), click the checkbox to the left of the component name.  
• To change the Amount, Unit Cost, and Share Rate options, double left-click in the appropriate textbox 

and enter the changes.  Changes must be made in the Components Window. 
• Once a component is checked it will appear in the Contract Items Window. 
• To delete an item, left click on the gray box to the left of the item in the Contract Items Window and 

press the Delete Key. 
• Once you have selected the components for all scheduled practices, click the Save Button. 
• Note: Contract information MUST be saved for it to be uploaded into ProTracts.  
• Note: Contract support documents for CSP, EQIP and WHIP should be produced in ProTracts. 

Toolkit planning/contract component information is only available in ProTracts after the customer file 
has been checked in to the National Conservation Planning Database. 

• Click the Next Button. 
• By default the current customer will be added in the Select Participants Window. If you have an 

Associated Customer click the List of Participants pull-down menu, select the customer and click the 
Add Button.  The customer’s name is added to the bottom of the screen.   

• Note: You can also manually add a participant by manually typing in the customer information and 
clicking the Add Button.    

• To remove a participant, select a person from the bottom list and press the Delete Key.   
• Click the Next Button to continue. 
• Set preferences, enter contract number and add/edit signature box information (as needed). Tip: 

Enter ‘Farm Service Agency’ in the Other Sponsoring Agency textbox to produce a signature box. 
• Click the Finish Button. 
• In the Save Excel File As Window, the filename is the previously entered Contract Identifier. 

Change the filename if you desire. Click Open Button to save the file. Note: It is strongly 
recommended to use the tract (or farm) number and program name for the filename (e.g. 
T1428_EQIP.xls). 

• Check to be certain the plan is complete and accurate. When you are satisfied with the plan, select 
Save from the File Menu. 

• Select Print from the File Menu to print your document. 
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Operating Toolkit without ArcGIS 
 
Creating a New Plan 
• Click on the Land Units Tab. In the Plan pull-down menu, select Create a New Plan.   
• In the Create New Plan Window, enter the new name of the conservation plan and click OK. Note: It 

is strongly recommended to use the tract (or farm) number and program name (e.g. T1428_EQIP).  
• Click the Add Land Units Button. Enter the Tract Number, Land Unit, Acres (FSA Program 

Acres), NRCS Land Use, and CRA. Note: If a CRA is not selected, Conservation System Guides will 
not be available in the Practice Scheduler. 

• To add another field, click the Add Land Units Button and another row is added to the list.  Repeat 
until all the land unit information has been entered.   

• Refer to Scheduling Practices. 
Select Existing Plan 
• Click on the Land Units Tab. In the Plan pull-down menu, select name of the desired plan.  
• If necessary, make additions to or edits to the land unit information. Note: Once land units are 

mapped, no changes can be made to them in the Land Units Tab. 
• Refer to Scheduling Practices. 
Scheduling Practices 
• Click the Practice Schedule Tab.   
• In the Land Units Section (upper left corner), a list of tract number(s) should be present. If not use 

the pull-down menu to select the conservation plan.  
• To display all the land units for your particular tract, click the plus sign to the left of the tract number. 
• Click the checkboxes next to the land unit number(s) for which you want to schedule a practice.  

Note: All checked land units will receive the practice(s) you schedule.  
• If desired, click the Guides Button in the Conservation System Section, to select a Conservation 

System Guide. Next, click the Systems Button to select a Conservation System. Once a guide and 
system are selected the practices for that system appear in the window below. The user select which 
system practices to schedule and may add additional practices from the Practices Section. 

• To select a practice(s), click in the gray box to the left of the practice code in the Practices Section. 
To choose multiple practices, hold down the Ctrl Key and click on multiple practices. 

• To schedule the selected practices, click the Schedule Practice Button.  
• Enter the appropriate information (narrative code, planned amount, cost share program, etc.) in the 

Schedule Section. Note: the Copy to Cell Below Button can be used to duplicate cell information.  
• Tip: Click on the R Button to the right of the Planned Year to schedule a Recurring Practice. 
• After you have scheduled all the practices for the land units, click the Save Button.   
• To continue scheduling on additional land units, return to the Land Units Section uncheck the 

previously checked land units and check the boxes for the next land units you wish to schedule 
practice on.  When complete, click the Save Button.  

• Return to the Land Units Section and click the land unit number checkboxes to be included in the 
plan or contract. 

• Tip: You can use a click and Shift or Ctrl Key to select specific items in the Schedule Section. Only 
selected items appearing in the Schedule Section will be included in the conservation plan or 
contract. If no items are selected then all items are included. 

• Once scheduling is complete, click on Plan Wizard Button to produce a conservation plan or 
Contract Wizard Button to produce a contract. 

• Refer to Develop a Conservation Plan and/or Develop a Contract Support Document Section(s). 
 
 



 32

ADDITIONAL ITEMS OF INTEREST 
 
Delete a Conservation Plan from a Customer Folder:   
 
• Click on the Folders Tab.   
• Locate the Customer Folder in the Folders Checked Out by <NAME> Window. 
• Left click on the gray button to the left of the Customer Folder to select it. 

• Click the Delete Folders or Plan Button ( ). 
• In the Delete Folders or Plan Window use the Plan pull-down menu to select the desired plan. 
• Click the Remove Plan Button and answer Yes to remove the plan from the National Conservation 

Planning Database. 
• Note: You must have the proper permissions to perform this operation.  
• Note: This removes all information related to that specific conservation plan (including GIS data and 

contract information) 
 
Delete a Customer Folder:   
 
• Click on the Folders Tab.   
• Locate the Customer Folder in the Folders Checked Out by <NAME> Window. 
• Left click on the gray button to the left of the Customer Folder to select it. 

• Click the Delete Folders or Plan Button ( ). 
• Click the Remove Folder Button and answer Yes to remove the folder from the National 

Conservation Planning Database. 
• Note: You must have the proper permissions to perform this operation.  
• Note: This removes all information related to that customer folder (including any information saved in 

the customer folder) 
 
Unlock a Customer Folder:   
 
• Click the Folders Tab.   
• Locate the Customer Folder in the Folders Checked Out by <NAME> Window. 
• Left click on the gray button to the left of the Customer Folder to select it. 

• Click the Release Lock on Folder Button ( ). 
• Answer OK to remove the lock on the folder in the National Conservation Planning Database. 
• Note: You must have the proper permissions to perform this operation.  
• Note: This causes the version of the folder on your computer to become a read-only copy which may 

not be checked back into the National Conservation Planning Database. 
 
Delete a Read Only Customer Folder:   
 
• Click the Folders Tab.  Locate the Customer Folder in the Folders Checked Out by <NAME> 

Window. 
• Left click on the gray button to the left of the Customer Folder to select it. 

• Click the Delete Read-Only Folder from Hard Drive Button ( ). 
• Answer OK to remove the read-only customer folder from your computer. 
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ADDITIONAL ITEMS OF INTEREST (cont.): 
 
Change the Assigned County of a Customer Folder:   
 
• Click on the Folders Tab.   
• Locate the Customer Folder in the Folders Checked Out by <NAME> Window. 
• Left click on the gray button to the left of the Customer Folder to select it. 

• Click the Change County Button ( ). 
• In the Manage Customer Data Window use the New County pull-down menu to select the desired 

county. 
• Click the Check In New County Button and answer Yes to check the file into the selected county. 
• Note: You must have the proper permissions to perform this operation.  
 
Reporting a Customer’s Conservation Practices from Toolkit to PRS:   
 
These instructions are for reporting planning progress for a customer from Toolkit to PRS. It is strongly 
recommended that users review the reporting business rules prior to working in the Reporting Tab. To 
view the reporting business rules click the View Business Rules Button in the Reporting Tab. 
 
To be able to report from Toolkit, a land unit/practice (planned/applied) must have the following 
information: a Conservation Resource Area (CRA), latitude and longitude value, Conservation System 
Guide (CSG) and a conservation system.  The plan approval date and planned/applied dates must be the 
current fiscal year. There must be one or more organizations assigned to the work.  
 
Tip: By creating the Planned Land Unit (PLU) and practice information in ArcGIS first (then creating the 
conservation plan and assigning a CSG/system) the CRA and Latitude/Longitude will be determined 
automatically. For unmapped PLUs, the user will need to use the Map Pin Function in PRS. 
 
• With a customer file checked out, click on the Reporting Tab.   
• In Conservation Plan Section use the pull-down menu to select the correct conservation plan. 
• Use the pull-down menus to select the correct Plan Approval Date.  
• Check the appropriate boxes for in the Work Performed By Section. 
• In the Land Units Section use the checkboxes to select all the land units containing reportable 

practices. The practices are then listed in the Reportable Practices Section. 
• In the Reportable Practices Section check to make sure the Land Use, Guide and System data 

fields are completed. If they are not, return to the practice scheduler and select a CSG and system. 
• Note: If a land unit does not have an assigned CRA then you will be unable to select a Guide or 

System for that land unit. CRAs are automatically assigned if the land unit has been digitized in 
ArcGIS. For unmapped land units, a CRA can be assigned in the Land Units Tab. 

• In the Reportable Practices Section check to make sure each reportable practice has a CRA value 
and a checkbox in the Lat/Lon column.  

• Note: Lat/Lon values are automatically assigned if the land unit has been digitized in ArcGIS. For 
unmapped land units, the user will have to use the Map Pin Function in PRS. 

• When all necessary reportable business criteria have been met for the land unit and practice, a check 
mark will appear in the PRS(FY) column. This indicates the practice can be reported directly from 
Toolkit. 

• To report all practices that have a check mark in the PRS(FY) column click the Report After Check 
In Button. Reportable practices (planned or applied) that had a check mark in the PRS(FY) should 
now have the current fiscal year listed in italic. 

• Click the Save Button. 
• Note: The customer must be checked in for the PRS reporting to be complete. Reported practices 

take 24 hours to cycle into any PRS reports. 
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